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General Notice


When using this document, keep the following in mind:


1. This document is confidential.  By accepting this document you acknowledge that you are bound
by the terms set forth in the non-disclosure and confidentiality agreement signed separately and /in
the possession of SEGA.  If you have not signed such a non-disclosure agreement, please contact
SEGA immediately and return this document to SEGA.


2. This document may include technical inaccuracies or typographical errors.  Changes are periodi-
cally made to the information herein; these changes will be incorporated in new versions of the
document.  SEGA may make improvements and/or changes in the product(s) and/or the
program(s) described in this document at any time.


3. No one is permitted to reproduce or duplicate, in any form, the whole or part of this document
without SEGA’S written permission.  Request for copies of this document and for technical
information about SEGA products must be made to your authorized SEGA Technical Services
representative.


4. No license is granted by implication or otherwise under any patents, copyrights, trademarks, or
other intellectual property rights of SEGA Enterprises, Ltd., SEGA of America, Inc., or any third
party.


5. Software, circuitry, and other examples described herein are meant merely to indicate the character-
istics and performance of SEGA’s products.  SEGA assumes no responsibility for any intellectual
property claims or other problems that may result from applications based on the examples
describe herein.


6. It is possible that this document may contain reference to, or information about, SEGA products
(development hardware/software) or services that are not provided in countries other than Japan.
Such references/information must not be construed to mean that SEGA intends to provide such
SEGA products or services in countries other than Japan.  Any reference of a SEGA licensed prod-
uct/program in this document is not intended to state or simply that you can use only SEGA’s
licensed products/programs.  Any functionally equivalent hardware/software can be used instead.


7. SEGA will not be held responsible for any damage to the user that may result from accidents or any
other reasons during operation of the user’s equipment, or programs according to this document.


(6/27/95-  002)


NOTE:  A reader's comment/correction form is provided with this 
document.  Please address comments to :


 SEGA of America, Inc., Developer Technical Support (att. Evelyn Merritt)
 150 Shoreline Drive, Redwood City, CA 94065
 
SEGA may use or distribute whatever information you supply in any way 
it believes appropriate without incurring any obligation to you.
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READER CORRECTION/COMMENT SHEET


Chpt. pg. # Correction


Corrections:


General Information:


Your Name Phone


Document number Date


Document name


Questions/comments:


Keep us updated!
 If you should come across any incorrect or outdated information while reading through the attached
document, or come up with any questions or comments, please let us know so that we can make the
required changes in subsequent revisions.  Simply fill out all information below and return this form to
the Developer Technical Support Manager at the address below.   Please make more copies of this form if
more space is needed.  Thank you.


Fax: (415) 802-3963
Attn:  Manager,
Developer Technical Support


Mail: SEGA OF AMERICA
Attn:  Manager,
Developer Technical Support
275 Shoreline Dr.  Ste 500
Redwood City, CA  94065


Where to send your corrections:
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1.0 Preface


This product, equipped with a text editor, assembler, and object linker that operate
on Apple computers, is an integrated environment software that supports software
development of microcomputers.  Using the Macintosh’s superior interface, the
software of two types of standard CPU, that is the Z80 and the MC68000, can consis-
tently be developed beginning with the creation of the source code and ending with
the production of the object module.
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2.0 About the Operation Environment


• Model Macintosh series that can operate Kanji Talk 7.1,
with a CPU that is 68030 or later


• RAM capacity minimum of 8 Mbytes required


• HD capacity minimum of 300 bytes required


Installation


Do the following to install the software:


1. Insert the SDSS VER 1.0 program disk in the floppy disk drive of the
Macintosh.


2. Copy all files from the SDSS VER 1.0 program disk on to the hard
disk.  (You do not need to create a special folder.)


3. Eject the SDSS VER 1.0 program disk.


Starting Up SDSS
An icon like the one below should appear on the hard disk.  Double click this icon to
start up the program.


2
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3.0 Operation Overview of Integrated Environment


SDSS Integrated Environment Software can do the following:


• Create and edit (text edit) source files
• Manage source file projects (text batch management)
• Assemble source files (Z80, MC68000)
• Link object files (creates load module)


Creating and Editing Source Files


T XT   Source (text) files can be created in the SDSS program.  The file created ap-


pears as an icon that looks like the one at the left.  This icon tells you that the file was
created by the SDSS program.  Because these files have text attributes they can be
edited by other text editors.  Further, the SDSS program can be started up by double
clicking on this icon.  The text window of the file will open by double clicking the
icon.


Managing a Source File Project
In order to perform the assemble/link process, a source file must be added to the
project.


T X T


e L s t   X r f


  t 0 00 1. pr o j


sample1.asm


sample2.asm


sample3.asm


sample4.asm


To add a source file, don't drag-copy
its icon, use the Add command in the
Project menu.


T X T


T X T


T X T


Name                                   Lst Xrf
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When adding a source file, the source name
being displayed, as shown in the example to
the right, lets you know that the file has been
added.  In other words,  only information is
stored in the project (not the source file
substance.)


             The project is treated as one file,
              and an icon like the one to the left
              appears.


As shown in the examples below, the relationship between the project and source
has two possible configurations. In example 1, moving and managing files becomes
simple.


                              


T XT


Example 1


Example 2


T XT T XT


T XTT XT T XT


Note: Care must be taken in moving to other machines.
Positions of source files stored in projects are not guaranteed in the movement
time of other models.  Here the source is added again to the project.


Name Lst  X r f


  t 0 00 1 . p r o j


sample1.asm
sample2.asm
sample3.asm
sample4.asm


ON   ON
OFF  OFF


ON   OFF
OFF  OFF
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Name Lst  X r f


  t 0 00 1 . p r o j


sample1.asm
sample2.asm
sample3.asm
sample4.asm


ON   ON
OFF  OFF


ON   OFF
OFF  OFF


Added
source
names


Cross reference
file output ON/OFF


List file output
ON/OFF


The cross-reference and list file output switches when adding a project is:


       
List File (Lst)
Cross Reference (Xrf)


ON
OFF


When this is to be changed, click the letters of the switch to be changed (ON or OFF)
with the mouse.


You can also change the order of the sources.  Because assembling after a file that
produced an assembler error cannot be done, it is convenient to check single files.
Use the mouse to drag a file whose order you want to change, then release the
mouse button after you have moved the file to the desired location.


Name Lst  X r f


  t 0 00 1 . p r o j


sample1.asm
sample2.asm
sample3.asm
sample4.asm


ON   ON
OFF  OFF


ON   OFF
OFF  OFF


Name Lst  X r f


  t 0 00 1 . p r o j


sample1.asm
sample2.asm


sample4.asm
ON   ON
OFF  OFF


ON   OFF


OFF  OFFsample3.asm


moves
sample4.asm


to top
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Do the following by changing the sequence of the source while adding.


e t   X r f


  t 0 00 1. pr o j


sample4.asm
sample1.asm
sample2.asm


ON   OFF
ON   ON


OFF  OFF


OFF  OFF


sample3.asm


Current position


Position prior
to change


Clicking the scroll bar
rotates between the current
position and the original
position of the file moved


e t   X r f


  t 0 00 1. pr o j


sample3.asm
sample4.asm
sample1.asm


OFF  OFF
ON   OFF


OFF  OFF


ON   ON


sample2.asm


Direction of
rotation is fixed


Range of
rotation


Name                                                 Lst Xrf


Name                                                 Lst Xrf
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Source File Assemble


Assemble is executed by the Assemble or Assemble All Files command in the Project
Menu.  Both commands assemble by order sources added to the project.


• Assemble Executed only within a source that has been added to a
project  with no object file or with a source file that has been
renewed.


• Assemble All Files Assembles all sources added to the project file.
(Added in order)


If an assemble error occurs for any command, files cannot be assembled after as-
semble execution is stopped by the file.  “Assemble Complete !!” is displayed when
a file is succeessfully assembled; but if an error occurs, that information and the
error line are displayed in the information window.


Object File Link


Assemble is executed by the Link command in the Project menu.  This creates a load
module from the obtained object file set by assembling the source file added to the
project and can set the output format (Motorola S, Intel HEX, three types of binary),
the basic address, etc., by command.


Note:      The output formats of the load module has been added to the end of this manual.


Function Specifications 7
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4.0  Flowchart of a Unified Environmental Software (SDSS)


This flowchart simply illustrates what has been written up to now in this manual.


• Source File (Module) Files describing programs and data are called
modules when arranged in each function.


• Object (Module) Files that are created and assembled from
source files.


• Load Module Created through linking, these files are a
combination of object files created from source
files being added to a project.  This file is in a
format that can be executed by debug or target.


T XT


ObJ


START


Creation or revision of
source file by editor


Add to Project


Execute
Assemble


ERROR ?


Execute Link
(If necessary, set options)


START


YES


NO


Group of Source Files
These are also called modules


T XT


Create


Project File


Created by user


T XT


Create


Object File List File


Create
T XT


Load Module
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5.0   MENU REFERENCE


File Menu
The source (text)  create, save, and print commands, and commands to open and
close pre-existing text are in the File menu.


N


O


W


P


S


Q


File
New
Open...


Close
Save


Save As...


Page Setup...


Print...


Quit


New  (Shortcut:  Command-N)
Creates and opens a new text window.  The name of the window at this time will be
“untitled”.


            


 Untitled 1
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Open  (Shortcut:  Command-O)
Opens pre-existing text.  The Macintosh standard file dialog box is displayed and
you can select the file you want to open from inside the box.


NewEdit8-Z80 MacintoshHD


Open


Cancel


Desktop


Eject68K_A.ASM


68K_A.LST
68K_B.ASM
68K_B.CRF
68K_B.LST
68K_MOVE.ASM
68K_MOVE.LST
active.c


Current
disk name


List of text
file names


The file names displayed here are limited to TEXT file types.


Close  (Shortcut:  Command-W)
Closes the text window currently being edited.  If changes have been made in the
text, the following save dialog box will appear.


10
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Save  (Shortcut:  Command-S)
Writes to the file the text currently being edited.  The text edit keeps the window as
it is, without interrupting.


Save As ...
Save As lets you save currently edited text into the file while changing the file name
to be different from the current window title.  The file name is specified within the
Macintosh standard file save dialog box, which appears as below.  The text edit
keeps the window as it is, without interrupting.


NewEdit8-Z80 MacintoshHD


Save


Cancel


Desktop


Eject68K_A.ASM


68l 2.proj
68l t-2proj
68K_A.ASM
68K_A.LST
68K_A.OBJ


6868.proj


New Folder


Untitled 1


Save current document as:Input name of
file saved


Page Setup ...
Sets the page size and options for printing.
The dialog box displayed here will be different depending on the type of printer you
selected in Chooser under the Apple menu.  Please refer to the printer manual.
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Print  (Shortcut:  Command-P)
Prints the contents of the text window that is currently open.


Quit  (Shortcut:  Command-Q)
Quits SDSS.  Automatically closes the text and project windows currently open.  (If
any changes have been made, the confirm dialog box is displayed at the same time
as “close.”)


12
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Edit Menu
The Edit menu has standard Macintosh edit commands including cut and paste, and
customized functions keys used by the editor.  Since Undo, Cut, Copy, Paste, and
Select All are all standard Macintosh commands, they will not be explained here.


                  


Set Shortcut Key
A shortcut key is assigned to each command of the Special menu, and can be
changed using this command.


Default: Returns to default value
Cancel: Cancels changes
Set: Quits setwindow


Function Specifications 13
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How to Set Shortcut Keys
The following describes how to set a shortcut key.


(1) Click the mouse button on the item you want to set.


(2) The selected item will become highlighted.  Pressing keys changes the
shortcut key setting display (keys are limited to letters, arrows, TAB, and
DEL keys).


Move up 1 row


Move up 1 row


^ Q


^ M
When M  is pressed


(3) Changes take effect when you click Set.
The Cancel button cancels any changes (returns to the conditions prior to
the change).
The Default button sets values to their default value.


Notes:


• The ^ symbol refers to the Control key.  (You cannot change to other keys such as the
Option key).


• When more than one item is assigned to the same key, only the first setting is valid.  Other
items set can not be used.


14
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Find Menu
The Find menu has a character string find command and character string replace
command that operates in a text window.


                                     


Find  (Shortcut:  Command-F)
This function locates any character string from within the active text window.  By
inputting the required item, the dialog box below appears and searches for character
strings that meet the conditions.  If that item exists, the position of the screen is
adjusted so that the line with the character string is displayed and the character
string that is found is highlighted.


    


Find what —— Area for inputting the character string
you want to find.


Find options —— There are three options, clicking each
small square button activates each
function.  The options are:


• Upward: Searches upward from the current line.
(Normal search is downward)


• Ignore case: Searches for same character alignment
regardless of upper or lower case.
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• Word Unit: Handles a character string as a single unit.


In the following example, when WORD is input
and searched, only WORD in the first line is
found and displayed.


Example:


WORD A
WORD1 B
WORD2 C
WORD3 D


16
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Replace  (Shortcut:  Command-R)
This is a function that searches any character string from among active text windows
and replaces it with a specified character string.  By setting the necessary items in
the dialog box, the character strings you want to replace is searched and replaced if
found.  (If the “Replace all” box is not checked, the confirm dialog box will appear
for each character string.)


Replace with


Replace all Ignore case Word unit


OkCancel


Find character string


Replace start buttonCancel button


Check this box to replace without
using confirm dialog box


Input
character
string


Input
character
string to be
replaced


When Find next is selected, the replace confirmation dialog box appears and con-
firms replacement.


Do you really want to replace?


Find nextQuit Ok


Quit replace Replace Do not replace, search for
next character string


Function Specifications 17
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Repeat Above  (Shortcut:  Command-T)
This is the Find repeat command that searches text upward from the current line
(towards the beginning of the file).  Character strings to be searched are set by the
Find command.  In short, this command lets you search continuously without hav-
ing to input the character string to be searched over and over again.


Repeat Below  (Shortcut:  Command-J)
This is the Find repeat command that searches text down from the current line
(towards the end of the file).  Character strings to be searched are set by the Find
command.  In short, this command lets you search continuously without having to
input the character string to be searched over and over again.


18
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Jump Menu
The Jump menu has six commands for quickly moving the cursor in the active text
window to a desired location.


                                


Top Line
Moves cursor to the first line of a file.


Set Mark
Puts a mark at the current insertion point (cursor).  Although nothing is displayed,
the Set Mark command can move the cursor to any line specified by the mark from
any line.


Marked Line
The Marked Line command can move the cursor to lines specified by the mark.


Specify Line...
You can move the cursor to the "Line No:" as in the dialog box below.


Row No:


Cancel Ok


Cancel button Jumps to selected
row number


Enter the row
number to be
moved to
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Previous Line
Cursor jumps to the line before the current position.


For example,  you can move to the first line from the bottom line by using this com-
mand.


Bottom Line
Moves the cursor to the bottom line in a file.


20
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Options Menu
The Options menu has seven commands that define the operating environment of
the active text window.  These commands function independently in each window.
A check mark is displayed at each selected function for easy reference.


Show Line No.
Displays the line number in the lead of each text line.


  68K_A.ASM


1 :  DC $80$
2 :  sound_top equ $20000
3 : voice_top equ $30000
4 : sound_ram equ $ ff f000
5 : ;
6 :         ABCD.B D1,D2
7 :         ABCD.B - (A1),- (A2)
8 :         ADD 255(A0),D1
9 :         ADD D1,255(A0,A1)


Underline
Underlines cursor line.
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Show Line Feed Character
Displays an arrow (↓) at the spot of the line feed character.


  68K_B.ASM


1 :  Start   DBCC D0,START  ↓
2 :    BSR SUBROUTINE_1  ↓
3 :   JSR $04(PC,D1,L)  ↓
4 :  SUBROUTINE_1 UNLK A1  ↓
5 :   NEG $FFFF5555  ↓
6 :           TRAP #15  ↓
7 :           MULS (A2),D0  ↓
8 :           LINK A1,#$FFFF  ↓


Show Tab/2-Byte Space
Displays spaces at locations where a tab code space exists.


Auto Indent
When indenting a line, indentation of the next line follows the indentation of the line
before it.


Tab Interval
Sets how many characters will be jumped when TAB is set.  The default value is four.
(Half size spaces of four characters)


Create Backup
Creates a backup file when a file is opened.


Enter tab interval:


Cancel Ok


4
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Project Menu
Commands within the Project menu include managing the project window and
executing the assemble and linking commands.  This menu can do most operations
except text editing.


New Project
Opens a new project window.
This command cannot be used when a project is open.  In the example below, type
the  project name to be displayed in the dialog box.  The extension “.PROJ” is auto-
matically added to the file name.


NewEdit8-Z80


MacintoshHD


NEW


Cancel


Desktop


Eject


68K_A.ASM6868 proj


Untitled 1


File name:


68l 2.proj
68l t-2proj
68K_A.ASM
68K_A.LST
68K_A.OBJ
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When the dialog box that asks what type of CPU you want to use for the open
project appears, click the CPU you want to use.  One project corresponds to only one
CPU.


Z80


MC68000


Ok


CPU select


CPU select button


Select confirmation button


The project window is opened when the selection is confirmed.


Name Lst  X r f


  t e s t 11 . p r o j


24
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Read
Reads projects that already exist.  When the file select dialog box appears, you can
designate which file to open.


NewEdit8-Z80 MacintoshHD


Open


Cancel


Desktop


Eject
68K2.proj
68kt-2.proj
80Z.proj
lll.proj
SDSS68 proj
TakaEdit.p
test1.proj


TEST11.proj


Current
disk name


Project file
name list


The file names displayed above are limited to “PROJ” files.


Save
Saves projects currently open.  You can continue without closing the project window.


Front
This command activates the project window.  This command can be used when the
text window is hidden behind other windows.
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SE
G


A 
C


on
fid


en
tia


l


     


Assemble  (Shortcut:  Command-K)
This command assembles sources added to the project.  However, it will not be
assembled in the following cases.


• When the object has already been created and there is no change in
the source.


• When there is an error in the file assembled previously.


Sources will not be assembled after an error occurs.  The source object file that pro-
duced the error is deleted at this time.


Assemble All Files
This command assembles sources added to the project.  All sources are assembled
without being checked for an Assemble command source change.  Sources will not
be assembled after an error occurs.


Displaying Assembled Results
An information window opens when assemble is executed and performs the follow-
ing information.


• After normal completion, “assemble complete !!” is displayed in each file.


  I n f o r m a t i on  w i n do w
68K_A.ASM  :  assemble  complete  ! !
68K_B.ASM  :  assemble  complete  ! !


When an error occurs, the line where the error occurred and the error type are
displayed.


  I n f o r m a t i on  w i n do w
68K_A.ASM  :  assemble  complete  ! !
68K_B.ASM  :  assemble  complete  ! !
68K_MOVE.AMS(25)  : Syntax error    <  MOVES  D0.D1      ; ERROR>


26
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Link  (Shortcut;  Command-L)
This command links source objects added to the project; it also creates a load module
file (file name is set by the Option command).  The results of the link are reported in
the information window the same as when executing assemble.


Option (Shortcut;  Command-Y)
This command sets all parameters used during the link process. The dialog box
shown below is used for making the settings.


•  Output MAP Checks for when a MAP file is required.
At the end of a normal link, the file with MAP as
an extension to the output file name is output.


•  Output Format Selects the format of the HEX file to be output.
Motorola S, Intel HEX, and Binary are exclusive of
each other and you can selected only one.
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•  Line Feed Code Selects the line feed code of the HEX file to be output.
You can select one of the following:
CR(0x0d), LF(0x0a), or CR+LF(0x0d0a)


•  Address The lead address of each segment is set as
hexadecimal numbers.  Eight digit input is possible, but
Z80 is valid for only the lower four digits.


•  Output File Name Sets the HEX file name.


28
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Source Menu
The Source menu adds sources to a project, and contains a delete command and
binary file edit command.


Source
Add
Delete


Edit binary file


Add
The Add command adds sources to a project.  Text is added when Add is used from
an active text window.  Also, if you use the project window when it is active, the file
select dialog box will appear and the file you selected will be added.


Note: The following files cannot be added to a project,


•  Files that have already been added
•  New files (text without a title).
     (An alert box like the one below will appear.)


Name Lst  X r f


  6868.pr oj
 Unt i tl ed- 1


Ok


Untitled text cannot be added to a project


Function Specifications 29


B F







SE
G


A 
C


on
fid


en
tia


l


       


•   Use Add when the project window is active.


NewEdit8-Z80 MacintoshHD


Open


Cancel


Desktop


Eject
sample1.asm


scroll.c
scut.c
search.c
SEDJMSG.C


TEST11.proj


sample2.asm
sample3.asm


SYS_MAIN.C


e t   X r f


  6868.pr oj


sample1.asm  ON OFF
Files selected by the file
select dialog box are added
to the project window.


Name                                             Lst     Xrf


•   Use Add when the project window is active.


              


Name Lst  X r f


  6868.pr oj


sample1.asm  ON OFF
sample2.asm  ON OFF


  sample3.asm


MOVE.B D1,D0


MOVE.L (A2),D0


  sample2.asm
Add
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Delete
You can remove a source from a project by specifiying and executing the source
added to the project.


Name Lst  X r f


sample2.asm  ON OFF


 t est1 .pr oj
Name Lst  X r f


sample2.asm  ON OFF


 t est1 .pr oj


sample1.asm  ON OFF Deleted


Deleting a file is done by clicking on the file name in the project window.  The file
selected will be highlighted.
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Edit Binary File
This is an expansion command that will be available in the future, but with today’s
version.  In its place, however, is the application binedit .  This application is for
display and edit of files by a hexadecimal binary code.  Operations like the one
shown below are possible.


  t e s t . H EX


 Address -0 -1 -2 -3 -4 -5 -6 -7 -8 -9 -A -B -C -D -E -F
 00000000 53 30 30 42 30 30 30 30 34 34 34 31 35 34 34 31
 00000010 32 30 34 39 32 46 34 46 46 33 0D 53 32 31 34 31
 00000020 32 33 34 35 36 35 36 34 36 34 36 35 36 36 43 33
 00000030 34 31 32 30 30 35 36 34 36 34 36 35 36 36 43 33
 00000040 34 31 32 30 30 37 42 0D 53 32 30 41 31 32 33 34
 00000050 36 36 34 45 46 39 30 30 31 32 33 34 37 34 34 38
 00000060 0D 53 32 31 34 31 32 33 34 36 43 35 36 42 34 30
 00000070 30 30 30 37 43 33 34 31 32 30 30 35 46 42 34 30
 00000080 30 30 30 37 43 33 34 31 32 30 30 41 31 0D 53 32
 00000090 31 34 31 32 33 34 37 43 35 36 42 34 30 30 30 30
 000000A0 36 43 33 34 31 32 30 30 35 36 42 34 30 30 30 30
 000000B0 36 43 33 34 31 32 30 30 42 31 0D 53 38 30 34 30
 000000C0 30 30 30 30 30 46 42 0D


Keys that can be used:


0 ~ 9 Inputs the number of the current position of the cursor.
Inputting overwrites older data.


A ~ F A hexadecimal number can be input in the current
position of the cursor.  Inputting overwrites older data.


DELETE Deletes one byte at the current position of the cursor.


I Inputs 00 in single bytes in the current position of
the cursor
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Window Menu
The Window menu has a command that closes all text windows curently open.  It
also has a command for changing text windows.


Window


Close All


Save All


.


.


The titles of all open text
windows are displayed
here.


Close All
Closes all text windows that are currently open.  Windows are closed automatically
by selecting this command.  (However, if there are changes, a dialog box will appear
allowing you to save the changes before closing.)


Save All
Saves then closes all text windows that are currently open.  Windows are closed
automatically by selecting this command.


Change Text Window
The titles of all text windows currently open are shown in the menu.  The windows
selected from the menu become active.
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  sample1.asm


move.w  d0,d1


MOVE.D D1,D0


  sample3.asm  sample2.asm


MOVE.L (A2),D0


MOVE.B D1,D0


  sample3.asm Window
Close All
Save All


sample1.asm
sample2.asm
sample3.asm


Selecting sample1.asm from
among the three windows above
activates the sample1.asm win-
dow as shown below.


  sample1.asm


MOVE.D D1,D0


  sample3.asm  sample2.asm


MOVE.B (A2),D0


  sample1.asm


move.w  d0,d1
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Special Menu
The Special menu lets you select items, using the mouse, that can be set by the Set
Shortcut Key command in the Edit menu.  It also includes text display change
commands (font, size, style).  Each command has a sub- menu.


Move up 1 row   ̂E
Move down 1 row   ̂X
Move left 1 column  ^ A
Move right 1 column   ̂F
Move to left edge of row   ̂←
Move to right edge of row   ̂→
Move to next tab  ^ [TAB]


Special
Move Cursor
Input/Delete
Scroll
Font
Size
Style


Plain
Bold
Italic
Underline
Outline
Shadow


 9
10
12
14
16
18
24


Delete 1 character at cursor    ̂G
Delete 1 character left of cursor   ̂H
Delete cursor row     ̂Y
Delete to end of row    ^ T
Cursor left from start of row   ̂U
From start of row to cursor    ̂B
Insert 1 row above cursor row   ̂N
Insert 1 row below cursor row   ̂M


Scroll down 1 row  ^
Scroll up 1 row  ^
Scroll down half screen  ^  ↓
Scroll up half screen  ^  ↑


Font 1
Font 2
Font 3
 .
 .
 .


Function Specifications 35


←
→


↑
↓







SE
G


A 
C


on
fid


en
tia


l


       


Move Cursor
This is a set of commands for moving the cursor within the active text window.
These commands can be operated by keys set by the Set Shortcut Key command in
the Edit menu.  Shortcut keys currently used are on the right side of the menu.


Move up 1 row   ̂E
Move down 1 row   ̂X
Move left 1 column  ^ A
Move right 1 column   ̂F
Move to left edge of row   ̂←
Move to right edge of row   ̂→
Move to next tab  ^ [TAB]


Current shortcut key settings


Delete/Insert
This set of commands inserts and deletes characters within the active text window.
These commands can be operated by keys set by the Set Shortcut Key command in
the Edit menu.  Shortcut keys currently used are on the right side of the menu.


Delete 1 character at cursor    ̂G
Delete 1 character left of cursor   ̂H
Delete cursor row     ̂Y
Delete to end of row    ^ T
Cursor left from start of row   ̂U
From start of row to cursor    ̂B
Insert 1 row above cursor row   ̂N
Insert 1 row below cursor row   ̂M


Current shortcut key settings
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Scroll
This is a set of commands for scrolling within the active text window.  These com-
mands can be operated by keys set by the Set Shortcut Key command in the Edit
menu.  Characters at the right side of the menu show the shortcut keys that are
currently used.


Scroll down 1 row  ^
Scroll up 1 row  ^
Scroll down half screen  ^  ↓
Scroll up half screen  ^  ↑


Current shortcut key settings


Scrolling down one line moves you down a single line:


   68K_A.ASM


1 :  DC $80$
2 : sound_top equ  $2000
3 : voice_top equ  $3000
4 : sound_ram equ  $fff000
5 : ;
6 :  ABCD.B D1,D2


   68K_A.ASM


2 : sound_top equ  $2000
3 : voice_top equ  $3000
4 : sound_ram equ  $fff000
5 : ;
6 :  ABCD.B D1,D2
7 :  ABCD.B - (A1),- (A2)


Scrolling up one line moves you up a single line:


   68K_A.ASM


2 : sound_top equ  $2000
3 : voice_top equ  $3000
4 : sound_ram equ  $fff000
5 : ;
6 :  ABCD.B D1,D2
7 :  ABCD.B - (A1),- (A2)


   68K_A.ASM


1 :  DC $80$
2 : sound_top equ  $2000
3 : voice_top equ  $3000
4 : sound_ram equ  $fff000
5 : ;
6 :  ABCD.B D1,D2
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Down Half Screen scrolls down half the screen, or approximately three rows:


   68K_A.ASM


1 :  DC $80$
2 : sound_top equ  $2000
3 : voice_top equ  $3000
4 : sound_ram equ  $fff000
5 : ;
6 :  ABCD.B D1,D2


   68K_A.ASM


4 : sound_ram equ  $fff000
5 : ;
6 :  ABCD.B D1,D2
7 :  ABCD.B - (A1),- (A2)
8 :  ADD 255(A0),D1
9 :  ADD D1,255(A0,A1)


Up Half Screen scrolls up half the screen, or approximately three rows:


   68K_A.ASM


1 :  DC $80$
2 : sound_top equ  $2000
3 : voice_top equ  $3000
4 : sound_ram equ  $fff000
5 : ;
6 :  ABCD.B D1,D2


   68K_A.ASM


4 : sound_ram equ  $fff000
5 : ;
6 :  ABCD.B D1,D2
7 :  ABCD.B - (A1),- (A2)
8 :  ADD 255(A0),D1
9 :  ADD D1,255(A0,A1)
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Font
Changes fonts in the active text window.  Fonts that are added to the system folder
when an application starts up are read and added to the menu.  You can choose from
among the following fonts to use.


   68K_A.ASM


 DC  $80$
sound_top equ  $20000
voice_top  equ  $30000
sound_ram equ  $fff000
;
 ABCD.B D1,D2
 ABCD.B -(A1),-(A2)
 ADD 255(A0),D1
 ADD D1,255(A0,A1)
 ADDA.L $FFFF,A0
 ADDI   #5555,$12345678


Font changed from
Helvetica to Courier.


   68K_A.ASM


 DC  $80$
sound_top equ  $20000
voice_top equ  $30000
sound_ram equ  $fff000
;
 ABCD.B D1,D2
 ABCD.B -(A1),-(A2)
 ADD  255(A0),D1
 ADD  D1,255(A0,A1)
 ADDA.L $FFFF,A0
 ADDI   #5555,$12345678
 ADDQ.B #8,(A1)+
 ADDX D1,D2
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Type Size
Changes the character size in the active text window.  Sizes include 9, 10, 12, 14, 16,
18, and 24.  All characters within the screen will change to the size selected.


   68K_A.ASM


 DC  $80$
sound_top equ  $20000
voice_top equ   $30000
sound_ram equ  $fff000
;
 ABCD.B D1,D2
 ABCD.B -(A1),-(A2)
 ADD  255(A0),D1
 ADD  D1,255(A0,A1)
 ADDA.L $FFFF,A0
 ADDI   #5555,$12345678
 ADDQ.B #8,(A1)+
 ADDX D1,D2


;
;
;


Font changed from 12 pt. to 18 pt.


   68K_A.ASM


 DC  $80$
sound_top  equ  $20000  ;  sound
voice_top  equ  $30000  ;  voice
sound_ram equ  $fff000  ;  sound
;
 ABCD.B D1,D2     ;
 ABCD.B -(A1),-(A2)    ;
 ADD  255(A0),D1    ;
 ADD  D1,255(A0,A1)   ;
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Type Style
Changes the character style in the active text window.  Styles include plain (stan-
dard), bold, italic, underline, outline, and shadow.  All characters within the screen
will change to the style selected.


   68K_A.ASM


 DC  $80$
sound_top equ  $20000
voice_top equ   $30000
sound_ram equ  $fff000
;
 ABCD.B D1,D2
 ABCD.B -(A1),-(A2)
 ADD  255(A0),D1
 ADD  D1,255(A0,A1)
 ADDA.L $FFFF,A0
 ADDI   #5555,$12345678
 ADDQ.B #8,(A1)+
 ADDX D1,D2


;
;
;


Style change from plain to italic.


   68K_A.ASM
 DC  $80$
sound_top equ  $20000  ;  sound top address
voice_top  equ  $30000  ;  voice top address
sound_ram equ  $fff000  ;  sound ram top addre
;
 ABCD.B D1,D2    ;  C501
 ABCD.B -(A1),-(A2)   ;  C509
 ADD 255(A0),D1   ;  D228  0OFF
 ADD D1,255(A0,A1)   ;  D370  9OFF
 ADDA.L $FFFF,A0   ;  D1FB  FFFF
 ADDI #5555, $12345678  ;  0679  15B3  1
 ADDQ.B #B, (A1)+    ;  5019
 ADDX D1,D2    ;  D541
 ADDX -(A1),-(A7)   ;  DF49
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6.0    Assembler Overview


About the Assembler Statement
Source 1 line of the assembler can be described by the following forms.


[Label] <Command> <Operand> [Comments]


[ ] can be omitted but < > cannot be omitted if one or the other is described.  The
separating character of each element is a space or tab.


Example:    An example with MC68000


START MOVE.W D0, D1 ;  Contents in D0 sent to D1


label command operand comment


Label When jumping from another line, the label is used as a reference by
the name assigned to the description row.


With a maximum of 32 character, you must begin at the first column.
Characters that can be used are:


a to z, A to Z, 0 to 9,?, @, _  (underbar)


Numbers cannot be used in the lead character.


* As special functions
:   :   added to the end of the label means PUBLIC,
# #  added to the end of the label means EXTERN.


Comment This is an explanation added to make a program more easily
understood.
It begins with a ; (semicolon) and ends with indentation.
All characters in between will be treated as comments.
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Expressions
Expressions can be used freely in commands and operands.  Elements that make up
the expressions are listed below.


•  Symbols
•  Operators
•  Constants (numbers or characters)
•  Location marks


Symbols
Symbols use character strings defined as labels within an expression.


Operators
Operators and their priority order are listed in the table below.


Operator Meaning Priority Order


*


/


MOD


multiplication


division


remove remainder


1


+


-


addition


subtraction


2


SHR


SHL


shift left


shift right


3


LAND


LOR


LXOR


AND logic


OR logic


XOR logic


4


EQ


NE


LT


LE


GT


GE


equal


not equal


smaller than


equal or smaller


larger than


equal or larger


5


NOT


NOT1


HIGH


LOW


1 complement (Z80 only)


1 complement (68K only)


high order byte


low order byte


6
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Numerical Constants
Numerical constant is a number that is expressed by the following:


•  Binary
•  Octal
•  Decimal
•  Hexadecimal


b : 0 or 1
q : 0  to  7
d : 0  to  9
h : 0  to  9   A  to  F


Character Constants
Character constants are values, and considered ASCII code with one or two charac-
ters enclosed by quotation marks ( ‘ ).


Example:


‘ a’ .  .  .  .  61H
‘a b’ .  .  .  .  6162H


Location Marks
The location mark is expressed by “ * “ and is the location counter value at that time.


Example:


ABC EQU *
XXXX * + 2


Method Format Example


2


8


10


16


%bbbb bbbbB


qqQ qq0


dddd


$hhhh hhhhH


%0111 1000B


017Q 110


10 255 1000


$FF       1000H
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Attributes of an Expression
Symbols within the expression must belong to any of the following.


•  Absolute  (value is fixed)
•  Relative  (value is segment relative)
•  External reference  (symbol declared EXTERN)


Expressions, including these type symbols, must follow the rules below.


• All symbols used within a calculation other than addition and subtraction must
be absolute.


• Addition
One element must be absolute.
Relative + absolute becomes relative.
The elements of expressions containing external references must all be absolute.


• Subtraction
Relative - absolute is relative.
Subtraction by relative of equal segments are absolute.
Other elements of expressions containing external references must all be absolute.


The rules above apply in each step while evaluating an expression.


Example:


CSEG
ABC EQU *
DEF EQU *
GHI EQU *


DW ABC+DEF-GHI .  .  .   ERR
DW ABC+(DEF-GHI) .  .  .   OK
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7.0   Assembler Pseudo-Instructions


Pseudo-instructions are shown in the table below.


Classification Pseudo-instruction Function


Link Control ORG
ASEG
BSEG


CSEG
DSEG
COMMON
END
PUBLIC  GLOBAL  XDEF
EXTERN EXTRN XREF


Designates origin  
Designates absolute segment.
Designates for user and extensive use
segment.
Designates code and segment.
Designates data and segment.
Designates common block.
Ends program.
Designates externally defined name
Designates external reference name


Symbol
Definition


EQU
SET  DEFL


Value allocation
Temporary value allocation


Data Definition DB DEFB FDB
DW DEFW FDD
DC DEFM FCC
DS DEFS RMB


Defines bytes
Defines words
Defines characters
Allocates memory


Macro Control MACRO
ENDM
EXITM
REPT
IRP
IRPC


Defines macro
Ends macro definition
Interrupts macro definition
Repeats macro
Continues macro
Character string macro


Conditional
Assembler


IFDEF
IFNDEF
IFB
IFNB
IFE
IFNE
IFIDN


IFDIF


ELSE
ENDIF


Assemble if definition is complete
Assemble if there is no definition
Assemble if operand is a space
Assemble if operand is not a space
Assemble if expression value is 0
Assemble if expression value isn't 0
Assemble if 2 character strings are equal.
Assemble if 2 character strings differ.
Assembles by reverse conditions of future
IF.
End conditional assemble
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Classification Pseudo-instruction Function


Output Control .LIST
.XLIST
.MACRO
.XMACRO


.IF


.XIF


Outputs list
Discontinues output list
Outputs macro expansion
Discontinues output macro expansion.
Outputs condition skip
Discontinues output condition skip


Other INCLUDE       INCL
TITLE
PAGE


RADIX


Read file
Designates list title
Designates form feed or number of rows in
one page.
Designates radix
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ORG


ORG <expression>


Sets the <expression> value at the location and counter.  The code to be manufac-
tured is assigned from the address of that value.  <expression> must be an absolute
expression already determined by value.


Example:


address code
org 8000H


00008000 12345678 dl $12345678
00008004 30388000 move $8000.W,d0


BSEG, CSEG, DSEG, COMMON


BSEG
CSEG
DSEG
COMMON


These commands set the code and relative address in memory into the location and
counter.  After a command, the location and counter values become the final address
of each segment until that location value is not changed by ORG.  Also, when acti-
vated, the location and counter value of each segment are initialized by the value set
by the option.


Example:
DSEG
dw $0001
dw $0002
dw $0003
CSEG
move d0,$8000
jmp start


.


.


.
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When all modules are created individually:


Developer A


CSEG


org  $8000
.
.


DSEG


org  $9000
.
.


BSEG


org  $9500
.
.


No. 1


No. 2


No. 3


Developer B


DSEG


.


.


.


.


CSEG


No. 4


No. 5


.


.


Supposing each to be 
placed in order 
beginning with the 
lowest address


If these two modules are linked:


No. 1


No. 5


CSEG block


$8000


No. 2


No. 4


DSEG block


$9000


No. 3
BSEG block


$9500


As shown above, even modules that were created separately can be grouped to-
gether when linking parts that resemble each other.  Generally, CSEG is used exclu-
sively for programs and DSEG is used exclusively for data.  BSEG is peculiar to this
program (SDSS), and is an application segment that can be used freely by the user.
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END
Shows the end of the program.  Any program after END is ignored.


Example:
org $8000
add d0,d1


.


.


.
END


PUBLIC, GLOBAL


PUBLIC <symbol>{,<symbol>}
GLOBAL <symbol>{,<symbol>}


Symbols that are declared PUBLIC can refer to symbols within other programs.
The EXTERN declarative is necessary for using modules.


Example:


public


ret


movestart


andi    #$7f,d0start1


start


d0,d1


File 1


extern start
.
.


jmp start


.


jmp start1


File 2


OK


Error


EXTERN, EXTRN


EXTERN <symbol>{,<symbol>}
EXTRN <symbol>{,<symbol>}


To refer to symbols defined by other modules, an EXTERN declarative is required.
(See PUBLIC, GLOBAL example).
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EQU


<label>   EQU   <expression>


Assigns <expression> values to labels.


A label defined by an EQU pseudo-instruction cannot be redefined by parts of other
programs.  Also, <expression> can not use an outside reference or previously refer-
enced symbol.


Example:
abc equ $01
move.w #abc,d0


treated as 1


SET, DEFL


<label>   [:] SET <expression> (valid only for 68K)
<label>   [:] DEFL <expression> (valid only for Z80)


Assigns <expression> values to label.


SET pseudo-instructions, different from EQU, can redefine identical labels indefi-
nitely.  Limitations on <expression> are the same as with EQU.


Example:
abc set $01
move.w #abc,d0 ——— abc in this line is handle as 1
abc set $02
move.w #abc,d0 ——— abc in this line is handle as 2
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DB, DEFB, FCB


DB <expression> {,<expression>}
DEFB <expression> {,<expression>}
FCB <expression> {,<expression>}


The value of 8 bits corresponding to the operand <expression> is placed in memory.
More than one operand can be used, each separated by a comma.  Omitting the area
between commas has the same meaning as designating 0.


Example:


address code
org 8000H


00008000 12345678 db $12,$34,$56,$78
00008004 01020001 db 1,2,,1


DW, DEFW, FDB


DW <expression> {,<expression>}
DEFW <expression> {,<expression>}
FDB <expression> {,<expression>}


The value of 16 bits corresponding to the operand <expression> is placed in
memory.  More than one operand can be used, each seperated by a comma.  Omit-
ting the area between commas has the same meaning as designating 0.


Example:


address code
org 8000H


00008000 00010002 dw 1,2,,1
00000001


00008008 1234 defw $1234


52







SE
G


A 
C


on
fid


en
tia


l


     


DL


DL <expression> {,<expression>}


The value of 32 bits corresponding to the operand <expression> is placed in
memory.  More than one operand can be used, each seperated by a comma.  Omit-
ting the area between commas has the same meaning as designating 0.


Example:


address code
org 8000H


000080000 12345678 dl $12345678
00008004 1234 dw $1234


DC, DEFM, FCC


DC /<ASCII character string>/
DEFM /<ASCII character string>/
FCC /<ASCII character string>/


The character string is put into the ASCII code and that value is placed in memory.
The symbol that encloses the character string does not have to be a slash (/), but the
last symbol must be the same as the first symbol.


Example:


address code
org 8000H


00008000 61626364 dc /abcdef/
00008004 6566
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DS, DEFS, RMB


DS <expression>
DEFS <expression>


RMB <expression>


The amount of bytes designated by <expression> is maintained in memory.  <ex-
pression> must be an absolute expression with an already decided value.


Example:


address code


org 8000H
00008000 61626364 dc /abcdef/
00008004 6566
00008006 ds 100
0000806A C100 abcd d0,d0


MACRO ~ ENDM


<Macro Name> MACRO argument...,
.


ENDM


Macro definition is performed between MACRO and ENDM.
Limitations on <Macro Name> are the same as normal labels.


Example: When you want to define a name and telephone number as
character string data.


tel macro         name,no
dc     /name/
dc       /no/
endm


tel      TANAKA,12-3456
tel      KOJIMA,98-7788


Macro definition part


data definition using tel macro


The above data definitions are developed as shown on following page.
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tel TANAKA,12-3456
+00000000 54414E41 dc /TANAKA/
+00000004 4B41
+00000006 31322D33 dc /12-3456/
+0000000A 343536


tel KOJIMA,98-7788
+0000000D 4B4F4A49 dc /KOJIMA/
+00000011 4D41
+00000013 39382D37 dc /98-7788
+00000017 373838


Using macro definitions gives a program that is more advanced than using a group
of commands held by the original MPU (micro processing unit).  For example, data
definitions of telephone numbers are:


68K Command direct Macro Use
dc /TANAKA/ tel TANAKA,12-3456
dc /12-3456/ tel KOJIMA,98-7788
dc /KOJIMA/
dc /98-7788/


Here, the descriptor becomes simpler and easier to understand.


EXITM


EXITM


EXITM pseudo-instructions are used to force the end of MACRO, REPT, IRP, IRPC.
If EXITM is executed, macro expansion is immediately stopped and moves to the
next line.
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REPT ~ ENDM


<Macro Name>   REPT   <expression>
.


ENDM


REPT expands the part from REPT to ENDM only the number of times that the
absolute expression is displayed by <expression>.


Example:


REPT        4       
NOP
ENDM


REPT
NOP
ENDM
NOP
NOP
NOP
NOP


+00000000  4E71
+00000002  4E71
+00000004  4E71
+00000006  4E71


EXPAND


address    code


IRP ~ ENDM


<Macro Name>   IRP   <dummy>,<argument list>
.


ENDM


IRP expands until the argument list has been replaced by dummies.


Example:


IRP         X,<1,2,3,4>       
DB        
ENDM


IRP  X,<1,2,3,4>
DB   X
ENDM
DB   1
DB   2
DB   3
DB   4


+00000000  01
+00000001  02
+00000002  03
+00000003  04


EXPAND


address    code


X
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IRP ~ ENDM


<Macro Name>   IRPC   <dummy>,<argument list>
.


ENDM


IRPC has as an argument a character string, and expands by replacing each character
of the part until ENDM.


Example:


IRPC         X,123456       
DC            /X/
ENDM


IRPC
DB   /X/
ENDM
DC   /1/
DC   /2/
DC   /3/
DC   /4/
DC   /5/
DC   /6/


+00000000  31
+00000001  32
+00000002  33
+00000003  34
+00000004  35
+00000005  36


EXPAND


address    code
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IFDEF ~ ENDIF


IFDEF <symbol>


ENDIF


If <symbol> is predefined, assemble continues until ELSE or ENDIF.


Example:


aaa equ   1


ifdef  aaa
          move.w      d0,d1
          nop


endif


when this line exists, the 2 lines below 
will not be assembled


IFNDEF ~ ENDIF


IFNDEF <symbol>


ENDIF


If <symbol> is undefined, assemble continues until ELSE or ENDIF.
IFDEF ~ ENDIF has a reverse function.


Example:


aaa equ   1


ifndef  aaa
            move.w      d0,d1
            nop


endif


when this line doesn't exist, the
 2 lines below will not be assembled


IFB ~ ENDIF


IFB  <character string>


If there are no characters between “<“ and “>” assemble continues until ELSE or
ENDIF.


Example:
ifb <>


move.w d0,d1  ________  can assemble
endif
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IFNB ~ ENDIF


IFNB  <character string>


ENDIF


If there are characters between “<“ and “>” assemble continues until ELSE or
ENDIF.  IFB ~ ENDIF is a reverse function.


Example:
ifnb <abc>


move.w d0,d1  ________  can assemble
endif


IFE ~ ENDIF


IFE <expression>


If the value of <expression> is 0, assemble continues until ELSE or ENDIF.


Example:
bbb equ   1
ife bbb-1


move.w d0,d1  ________  can assemble
endif


IF ~ ENDIF, IFNE ~ ENDIF


IF     <expression>      or      IFNE     <expression>


If <expression> has a value other than 0, assemble continues until ELSE or ENDIF.
IFE ~ ENDIF has a reverse function.


Example:
bbb equ   1
if bbb-1


move.w d0,d1  ________  can not assemble
endif
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IFIDN ~ ENDIF


IFIDN <character string>,<character string>


If two character strings are equal, assemble continues until ELSE or ENDIF.  Charac-
ter strings must be enclosed  by “<“ and “>”.


Example:
ifidn <same>,<same>


move.w d0,d1  ________  can assemble
endif


IFDIF ~ ENDIF


IFDIF <character string>,<character string>


If two character strings are different, assemble continues until ELSE or ENDIF.
Character strings must be enclosed  by “<“ and “>”.  IFIDN ~ ENDIF has a reverse
function.


Example:
ifdif <same>,<same>


move.w d0,d1  can not assemble
endif      ________


ELSE, ENDIF


ELSE
ENDIF


ELSE performs assemble or skips according to conditions opposite of the leading
conditional assemble command.  Used in the form of IF** ~ ELSE ~ ENDIF.  ENDIF
shows the end of conditional assemble.


Example:
ifb <>


move.w d0,d1 can assemble
else


move.w d0,d1 can not assemble
endif
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.LIST, .XLIST


.LIST


.XLIST


.LIST is the condition allowing list output.


.XLIST is the condition not allowing list output.  .LIST is the default.  When the list
output switch is off in the project, list output will not be performed unconditionally.


abcd
.XLIST
abcd
abcd.b
.LIST
abcd


d0,d0


d7,d0
d2,d5


d3,d4


address        code


00000000   C100


00000002   C903


abcd                  d0,d0


abcd                  d3,d4


Source File List File


.MACRO, .XMACRO


.MACRO can output macro expansion list


.XMACRO can not output macro expansion list


Default is possible.  But when the list output switch is off in the project, a list cannot
be output unconditionally.


.XMACRO


.MACRO


tel    TANAKA,12-3456


tel     KOJIMA,98-7788


Assemble expansion is not displayed on the list


Expands assemble


Source File
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.IF, .XIF


.IF Able to output a list of lines skipped by the conditional assemble function


.XIF Not able to output a list of lines skipped by the conditional assemble function


In the default setting the list can be output.  But when the project list output switch
is off in the project, a list can not be output unconditionally.


Example:


bbb   equ 1
   .XIF
   if       bbb
            move.w d0,d1  ____ can assemble and output a list
   else
            move.w d0,d1  ____ can not assemble and output a list  
endif


INCLUDE, INCL


INCLUDE <file name>


INCL <file name>


Reads and assembles files displayed by <file name>.
INCLUDE permits nesting of up to 10 levels.


Example:


include      master.lib


if         bbb


move.w     d3,d4


bbb   equ   1


ccc   equ   2
read to


File name = master.lib


Source File


62







SE
G


A 
C


on
fid


en
tia


l


      


TITLE


TITLE   <character string>


Sets the title of the list file.


Example:
If     TITLE    TEST
are described in source file ABCD.ASM, in ABCD.LST created after assemble:


SDSS (MC68000) Cross Macro Assembler - Macintosh - Version 1.0   30 Nov. 1993


       


<ABCD.ASM> TEST


2 lines containing title characters in the location where the page
 is divided


RADIX


RADIX <expression>


Designates the radix.  The radix is designated to be 10 at the time of start up.
With <expression> as an absolute expression, the value must be either 2, 8, 10, or 16.


Example:


address code
radix 16


00000000 1234 dw      1234
radix 10


00000002 04D2 dw      1234


NAME, NAM


NAM
NAME


Designates the module name, which does not have to be designated.   If it is desig-
nated when linking, it will be displayed in the map file.
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8.0   List of  Assembler Linker  Error Messages


Output Message Remarks


Assemble error There is an error in the assemble file


The error is display along with the file name


Line invalid Line is not correct


No source file specified No source file was specified


Could not open file Source file could not be opened


Could not create file File could not be created


Too many nesting files File nesting is too deep (including nest)


Too many nesting macros Macro nesting is too deep


Label buffer full Too many labels


Macro buffer full Too many macros


Unterminated conditional control such as # if are not closed


Unterminated macro Macro is not closed


Not enough memory for SDSS Not enough memory to start up SDSS


Many errors There are too many errors


Relative branch out of range Long distance between relative jumps


Constant was expected No constant at location where it should be


Reference to multi defined Performs multiple definitions


Extra characters on line Unreadable characters exist


Already had ELSE clause There is no IF that corresponds to ELSE


Illegal expression Illegal expression
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Output Message Remarks


Label was expected Label was not at required location


Symbol is multi defined Duplicate symbols


Operand was expected No operand


Permanent label was expected No permanent label


Symbol is reserved word Reserved word was used


Unexpected end of strings String ends at an unexpected location


Too complex expression Expression used is too complex


Symbol not defined Undefined symbol


Value is out of range Value exceeds range


Symbol already external External symbol was used as local


Syntax error Syntax error


Division by 0 Divides by 0


Unexpected end of file End of file can not be found


BAD D8 RELATIVE Exceeded the range of the 8 bit relative address


BAD D16 RELATIVE Exceeded the range of the 16 bit relative address
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9.0   Load Module Output Format


Motorola S28
The following is one output format defined by Motorolla that outputs a 24-bit
address code.


S00B00004441544120492F4FF3 Sign on record


S214000000FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFC


Data record


S804000000FB End of file record


.


.


Contents of a data record are shown below.


S2 14  000000  FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF  FC


byte count (byte number (hexadecimal) after this byte)


Record lead characters
            (fixed)


24 bit address Data area Check sum


The check sum is a complement of single binary addition as far as the byte immedi-
ately before check sum within the code that contains the byte count, address, and
data.
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Intel HEX
The Intel format is one output format; it’s output is in a 16 bit address code.  Each
record begins with a colon (:) and then continues with the byte count.  After the byte
count is the 4 digit address (in hexadecimal), and the record type.  Next is the line of
data, and finally the check sum.


:10000000FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF00


Data record


:00000001FF End of file record


.


.


:10000100FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF00


Contents of a data record are shown below.


:  10  0001     00       FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF                   00


byte count (byte number (hexadecimal) after this byte)


Record lead characters
            (fixed)


16 bit address


Data area Check sumRecord type
(0=data, 1-EOF)


   


The check sum is a complement of double binary addition as far as the byte immedi-
ately before check sum within the code that contains the byte count, address, record
type, and data.


Binary Format Output
This is a format that outputs the linked hexadecimal data code just as it is.
Data can only be output without having to output information such as an address.
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